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***************************************
Opportunities Abound!
by Curt B. Witcher
***************************************
Oh my goodness, January 2014 is in the books – one of twelve for this year already history! And
what a month it has been, weather-wise. For the first time since the blizzard of 1978, The
Genealogy Center and the library were closed four times this month due to inclement weather.
Isn’t it wonderful, though, that even when we’re homebound, if we have an Internet connection,
hundreds of thousands of books (as well as a multitude of databases) are available for our use. The
twenty-first century is indeed the best of times of genealogists!
Though the shortest month of the year, this February is packed with activities and opportunities.
*In just a few hours, millions of individuals will be enjoying this year’s Super Bowl. Certainly many
gather to watch the game, though a surprising number are every bit as interested in the much
talked about commercials, and still more likely enjoy another opportunity to gather for good
conversation and good food. For many families this has become an annual tradition.
*In just a few days, RootsTech 2014 will kick off in Salt Lake City, UT with an Innovator Summit on
Wednesday, February 5th. The conference itself, expected to draw well north of 10,000 attendees,
is the largest such event in the North American family history space and runs Thursday through
Saturday, February 6th-8th. What can be more exciting than the intersection of technology and
genealogy? For the genealogists who can’t make it to Salt Lake City, a significant number of the
sessions will be streamed live. Hence, you will be able to participate in some of the events from

anywhere in the world. Check out the possibilities at www.RootsTech.org.
*In just a week, the Winter Olympics will get underway in Sochi, Russia. So many Americans enjoy
following the successes of the United States Olympians. As with the Super Bowl, some families
have made a tradition of gathering to cheer on their favorite competitors.
Okay – so this is a genealogy ezine that highlights collections and activities in The Genealogy Center
with a number of tips and some advice mixed-in, right? So why am I commenting on the weather,
the Super Bowl, the Olympics, and a conference? I am hoping to demonstrate in a simple,
straightforward way that there truly is no excuse for not writing your family’s history. No, I don’t
mean collecting information about your family and your ancestors – I mean actually writing their
stories, and actually capturing living memory as well.
When a new year dawns, many use that changing of the calendar to motivate them to new activities.
Some made a commitment to write more in the New Year. For many, those good intentions quickly
are abandoned, and usually with a sigh and an exclamation that “I don’t have anything to write
about.” If you feel that way, you likely are not being creative enough. Assuredly there are
opportunities to write every day – we just need to make ourselves aware of them.
Allow activities in the news to prompt you to write about similar activities of yesteryear. Let the
Super Bowl prompt you to recall memories of playing sports when you were young, or watching your
children and grandchildren engage in sporting events. Write about the Little League baseball games
and flag football; recall the weekend pick-up kick-ball games on school playgrounds; recount building
snowmen, snow forts, and having snowball fights, and staying outside so long your fingers and toes
tingled; and pen your recollections of hop-scotch and playing marbles.
Let the today’s weather prompt you to remember thunderstorms and snowstorms when you were
little. Recall if you ever went to your cellar because of a storm, or laid awake late at night with a
sibling counting the seconds between the lightning flashes and the thunder to muse about how close
the storm was. Remember if you ever walked in the rain, or stomped in the middle of a big puddle to
get your friend all wet. Did you ever talk with your grandmother about her thunderstorm
recollections when she was a young child?
Reading the daily paper or watching the latest Yahoo news feeds should provide one with plenty of
memory-triggers to literally write for the rest of your life. Indeed, opportunities abound!
Finally, speaking of opportunities, further on in this ezine you will find an absolutely amazing line-up
of top-shelf programs being offered in February, March, and April of this year. Don’t miss these
fantastic learning and networking opportunities. Join us to celebrate Black history, Women’s
history, March Madness Genealogy-Style, and National Preservation Week.
***************************************
Middle Tennessee Atlases and Land Grant Genealogy
by Delia Bourne
***************************************
In 1783, the state of North Carolina set aside land in what is now middle Tennessee as payment for

militia and Continental Line soldiers of the American Revolution. Military warrants for land were
awarded, with the size of the grant varying from 640 to 12,000 acres, depending on the individual’s
rank. The warrants received by veterans or heirs of those killed in battle or defending settlements
could be – and often were – sold before an actual grant was made, so settlement in the area does
not prove military service. Others were eligible for land grants in the area by preemption – they
lived in the District before it was formed in 1780. The first land office opened in Hillsborough,
North Carolina, in 1783, with new offices organized in 1784. An entry taker and a county surveyor
were appointed. All land was located in what was then Davidson County.
Three atlases, published separately but constituting a set, deal with the settlement of this area in
Tennessee. Doug Drake, Jack Masters and Bill Puryear are the authors of all or part of these
volumes: “Founding of the Cumberland settlements: the first atlas, 1779-1804” (976.8 D789F);
“Thoroughfare for freedom: the second atlas of the Cumberland settlements, 1779-1804” (975.6
D789FA); and “The first Southwest: the third atlas, the Cumberland and Duck River settlements,
Tennesseans expand our nation south and west” (976.8 D789FD).
All of the volumes are lushly illustrated with photographs, sketches and maps, and detail the history
of the area with varying amounts of biographical information. They also contain, divided into the
three volumes by region, plats of the grants on current USGS maps, showing old road systems,
streams and other features used by original surveyors. The different volumes have various useful
items for the researcher. Volume 1 has a list of the Cumberland Pact signers and a timeline. Volume
2 contains a list of Tennessee Revolutionary War patriots and sales of slaves 1789-1804, noting
seller, buyer, and name of the slave. Volume 3 describes Tennesseans in the Westward Expansion,
especially in Texas.
Four supplemental volumes were also published which provide transcriptions of the North Carolina
land grants in the districts, with the warrants, surveys and surveyor plats that these atlases cover.
“Land grant genealogy,” volumes 1 and 2 (976.8 D789FA, v. 1 and 2), covers the first atlas and
includes all or portions of Cheatham, Davidson, Jackson, Macon, Montgomery, Robertson, Smith,
Sumner, Trousdale, Williamson and Wilson Counties. The third volume, “Land grant genealogy, the
second atlas 1779-1804, data supplement” (976.8 D789FB) is a supplement to “Thoroughfare for
freedom,” and covers all of Rutherford, Williamson and Wilson Counties, portions of Davidson and
Smith Counties not in volumes 1 and 2, and portions of Cannon, Cheatham, DeKalb, Putnam, Sumner
and Trousdale Counties. The fourth volume is “Land grant genealogy, the third atlas, data
supplement” (976.8 D789FC), companion to “The first Southwest,” and includes all of Bedford,
Dickson, Marshall and Maury Counties, the remainder of Cheatham and Montgomery Counties, a
majority of Hickman, Houston and Stewart Counties, as well as portions of Coffee, Giles,
Humphreys and Lincoln Counties. All four of these volumes also include sections describing the
components required for land grants, abbreviations used in land records, the format of the grants,
water drainages and an alphabetical grantees list.
These volumes are a tremendous resource for anyone with ancestors in this area of Tennessee, and
the images and detailed maps are a welcome addition.
***************************************
African American History Museums

by Melissa Shimkus
***************************************
Local and state African American History Museums can offer visitors an engaging and enriching
encounter with African American history, as well as presenting researchers access to records and
documents that may not be available in other collections. These materials can have a local focus or a
broader national scope. Some of these museums maintain or rotate exhibits and introduce learning
tools to showcase their materials, while others allow access to their collections in the form of
research libraries.
Several museums have started highlighting portions of their exhibits virtually on their websites,
which is a great way for users to see what types of materials can be found at the facility. For
example, the California African American Museum <www.caamuseum.org> provides information and
samples of current and previous exhibitions on its website. The National Underground Railroad
Freedom Center <freedomcenter.org> hosts a number of exhibits at its museum in Cincinnati, Ohio
and posts exhibit information online, including images and historical perspectives.
Other museums provide virtual access to their collections, as well as digital lesson plans for
students and educators. The African American Museum in Philadelphia (Pennsylvania)
<www.aampmuseum.org> maintains an online collections database featuring photographs and videos.
The DuSable Museum of African American History in Chicago, Illinois <www.dusablemuseum.org>
features lesson plans and worksheets on topics such as the Civil War, the “Amistad,” pre-Columbus,
Giza Pyramids and the Timbuktu Manuscripts on its website.
The Charles H. Wright Museum of African American History <thewright.org/> in Detroit, Michigan,
has several digital features on its website: Current and previous exhibitions featuring content and
videos, a photo gallery of exhibits and events from 2010 through the present, instructional
resources presenting an interactive timeline and oral histories covering 1865-1950, teaching and
learning modules for African American history, and a course about the Underground Railroad are all
easily accessible online.
In celebration of Black History Month, take advantage of these resources and visit an African
American History Museum, virtually or in-person. They are a great place to learn more about the
rich and diverse African American history and heritage.
***************************************
Technology Tip of the Month--Create Your Own PowerPoint Show
by Kay Spears
***************************************
When working with Microsoft PowerPoint, remember what our motto is: Keep it simple. You really
don't want your audience watching your show wondering how you did the amazing animation tricks
instead of listening to what you are saying.
So, let's put away our PowerPoint Wizard and start with a blank page. When you open PowerPoint,
Microsoft defaults to a page that already has some text boxes. For this exercise, we want to get
rid of them. If you are working with a version of Microsoft that has a ribbon, go to Home>Layout
and choose Blank. Or you can just click on these boxes and delete them, one by one. Now we will

practice adding some basic elements to a presentation. If you are familiar with Microsoft Word,
you might recognize some of these tools.
Let’s start with the background. Go to the Design tab. You will see that Microsoft has provided you
with a plethora of backgrounds. Ignore them. Since you are creating your own, go to Background
Styles>Format Background. When the dialog box opens up, you will see numerous options, but
because we are keeping it simple, just choose Solid Fill. Even that isn’t as simple as it sounds
because you still have multiple color options available. Choose whatever color you like. If you want to
use this color with every slide, before you close the dialog box click “Apply to All.” Once you do this,
all of your slides will have the same background color.
Next it's time to add a title. There are two ways to do this, depending on the results you want. You
can use either a Text Box or WordArt. WordArt can be bent/twisted/fish eyed, etc. Play with both
to see which fits your needs. For this article, I’ll describe using WordArt. Go to the Insert tab and
click on WordArt. A drop down box appears with different styles of the letter “A” in it. Choose
one. You should see a text box with the words “your text here.” Click inside that box and start
typing. When this box is active, you will see a box with “handles” on it around the text. There is also
a green dot in the middle of the top of this box. This green dot allows you to rotate your box. You
may also maneuver your text box anywhere on the slide by carefully placing you cursor over it and
waiting until the cursor changes to what appears to be a cross with four arrows on it. When this
happens, you can drag your title wherever you want it. Notice that because you picked WordArt,
the Drawing Tools tab is now available to you. With this tab open, you can format your text in many
different ways.
You might want to add an image or clip art to your presentation. If you choose to add a
photographic image, remember to be sure it is a low-resolution JPEG. Loading a TIFF to your
presentation is a waste of precious space and in most cases, computers and projectors are low
resolution, so there isn't any need for using something as large as a TIFF. A large TIFF will only
slow your presentation down. You may also use a GIF, which is an animated image.
To add clip art, go to Insert>Clip Art. A Clip Art Tool Pane will open up on the right side of the
slide. In the “Search For” box, type a keyword or phrase describing what kind of clip art you need,
for example, “boat.” You can narrow your search by selecting the type of media you want in the box
underneath. Your choices are illustrations, photographs, video, audio and all formats. For this
practice, choose illustrations. Next, click on “Go” and numerous illustrations appear. Just double
click on the illustration you want and it will appear on your slide. As with the WordArt, you can
format the size, location and color of your illustration.
One last step for creating a basic presentation is adding more slides. Go to Home>New Slide and
click. A second slide will appear and it should be the same background color as the first. You can
see both slides on the left hand side in the Slides view.
You have just created a simple PowerPoint presentation. Next month we will cover adding some
transitions to those slides.
***************************************

Quick-Tip of the Month for Preservation--Preserving Unconnected Information in a Searchable File
by Dawne Slater-Putt, CG(sm)*
***************************************
A common occurrence for virtually every genealogist is finding information about people who
*might* be related, or *probably* are related to the family, but the connection has not yet been
established. What do you do with this information? Most of us probably take notes and possibly file
those notes in a file folder under the surname of interest. But if you are like I am, you forget to
look at those notes regularly to see if you can place the orphan information.
Here’s another way of preserving those bits of as-yet unconnected information: Create a word
processing file for each surname or branch of the family and type the information into the files,
including complete citation information. You can arrange the bits of information in whatever order
makes sense to you; I list mine alphabetically by individual’s name. This way, all of the bits of
information I have on someone named “William Morgan,” for example, are grouped together. And
sometimes I find that several pieces of unconnected information in my file all belong to the same
person, even if I don’t yet know how he fits into MY family.
A spreadsheet might be another way to keep track of your unconnected pieces of information, by
labeling fields with headings such as “name,” “date of birth,” “place of birth,” “date of death,” “place
of death,” “spouse’s name,” “parents,” “source citation” and a “notes” field for other information. Or
if you use a genealogy software program, you could create an “Unknowns” database just for this
kind of information. The benefit of the latter is that you could link individuals together within the
Unknowns database as you found that they were related.
In each case, it’s important to go to these files and peruse them regularly to see if you have found
additional information that will allow you to move some of your “unknowns” into your own family files
or database. A big benefit of storing your unconnected information electronically, in whatever
format you choose, is that it is keyword searchable! Happy hunting!
*“CG” & “Certified Genealogist” are service marks of the Board for Certification of Genealogists,
and are used by authorized associates following periodic, peer-reviewed competency evaluations.
Certificate No. 386 awarded 4 July 1996; expires 4 July 2016.
***************************************
WinterTech Finale
***************************************
The last WinterTech class for this season will be “Apps & Programs for Genealogy” on Wednesday,
12 February 2014. This session will highlight the many types of applications for smart phones and
tablets – some also for computers – that can be used for genealogical purposes. This will be an
overview showing just a few examples of each type of application, though information will be
provided on how and where to find many more. Some examples that will be featured are to-do lists,
notes applications, journal applications, calendars, Siri and Google Voice, maps, photo applications
and more. WinterTech programs take place at 2:30 p.m. the second Wednesday of each month,
November through February, to coincide with the Allen County Genealogical Society of Indiana's
monthly meetings held at 6:30 p.m. Call 260-421-1225 or email Genealogy@ACPL.Info to register
for this free class.

***************************************
Basics of Adobe Elements Series in February!
***************************************
There are still spaces left for the “Basics of Adobe Elements Workshop,” a four-part series on
Monday evenings in February, 6 p.m. to 7 p.m. in the Computer Classroom. Learn the basics of Adobe
Elements. Discover how to restore images of old photographs using techniques similar to those in
Adobe Photoshop. Participants are encouraged to bring copies of their own family photographs on a
flash drive for hands-on instruction in applying what they have learned to their personal photos.
Space is limited. Copies of photos must be on a flash drive. This hands-on class has limited seating,
so register early by sending an email to Genealogy@ACPL.Info or calling 260-421-1225.
***************************************
Celebrate Black History Month in February!
***************************************
Help us celebrate Black History Month by joining us for any or all of these planned events:
* Thursday, February 13, 7:00-8:00 p.m., in Meeting Room B
“W.P.A. Slave Narratives and Race, Slavery, and Free Blacks: What Can You Find?” presented by
Roberta Ridley.
The regular meeting of the African American Genealogical Society of Fort Wayne will present a
look at the W.P.A. Slave Narratives and the information they provide in locating additional
information on ancestors, understanding the day-to-day lives of slaves, and the changing of
surnames. We will also take a look at the Race, Slavery and Free Blacks Collection/Petitions to the
Southern Courts records.
To register for this free event, call 260-421-1225 or email Genealogy@ACPL.Info.
* Tuesday, February 25, 2:00-3:30 p.m., in Meeting Room B – Back-to-back programs:
“Highlights of African American Military History,” presented by Dr. Alfred Brothers.
The presentation discusses African American faces in military history from the American
Revolution through World War II. It also highlights African American Medal of Honor awardees
throughout the wars.
“Looking at Herstory” presented by Judy Harris.
Research may require us to look beyond the context of the traditional family home and the role of
wife and mother when investigating female ancestors. Exploring where and how women of color
existed beyond the plantation might help break through a brick wall. By looking at working women of
the Antebellum South and using thoughtful imagination, participants may gather insights for
further inquiries.
To register for these free events, call 260-421-1225 or email Genealogy@ACPL.Info.
* Wednesday, February 26, 2014, 6:30-8:30 p.m., in Meeting Rooms A & B
Dr. John Aden will present a program on the African/African American Historical Society and
Museum. To register for this free event, call 260-421-1225 or email Genealogy@ACPL.Info.
* Thursday, February 27, 2014, 6:30-8:00 p.m., in Meeting Room A
“Haunting the House of History: African American Resources in The Genealogy Center” presented

by Curt Witcher.
This presentation will focus on The Center’s African American Gateway, the African American
Historical Newspapers, and the Slavery and Anti-Slavery Transnational Archive. There is an
abundance of historical data to be discovered in these important resources.
To register for this free event, call 260-421-1225 or email Genealogy@ACPL.Info.
***************************************
Celebrate Women's History Month in March!
***************************************
Women’s History Month events include research techniques on researching women, a study of a
fascinating group of courageous women who helped settle the West, and a single Fort Wayne
resident who had a world-wide impact on female scholars. Join us for three afternoons as we
celebrate Women’s History:
*Thursday March 13, 2-3 p.m., Meeting Room A.
“Finding Her: Our Female Ancestor” – Melissa Shimkus
* Friday, March 14, 2-3 p.m., Meeting Room A.
“The Harvey Girls” – Cynthia Theusch
* Saturday March 15, 2-3 p.m., Meeting Room A.
“Edith Hamilton of Fort Wayne, Indiana: Classics, Aesthetics, and the Origins of The Greek Way” –
Dr. Victoria Houseman
To register for these free events, email Genealogy@ACPL.Info or call 260-421-1225.
***************************************
March Madness, Genealogy Style 2014: Skillbuilding
***************************************
The theme for our annual March Madness, Genealogy Style in 2014 is Skillbuilding. Whether you are
fairly new to family history, or you have been at it for years, it’s good to learn new techniques and
refresh your skills on a regular basis. Join us for this year’s offerings as we aid you in learning new
skills or remind you on what you may have been overlooked. Classes are:
* Sunday, March 16, 1-2 p.m., Meeting Room A.
“Starting, or Starting Again: Having Fun Finding Family” – Curt Witcher
* Monday March 17, 2-3 p.m., Meeting Room A.
“What's So Vital About Vital Records?” – Delia Bourne
* Tuesday, March 18, 2-3 p.m., Meeting Room A.
“Tallying the Census: Counting Down Its Uses” – Melissa Shimkus
* Wednesday, March 19, 10-11 a.m., Meeting Room A.
“Using Tax Records in Genealogical Research” – John Beatty
* Thursday, March 20, 10-11 a.m., Meeting Room A.
“Read All About It! Historical Newspapers for Your Research” – Delia Bourne
* Friday, March 21, 10-11 a.m., Meeting Room A.
“More than a Prayer: A Look at the Records of American Churches” – Curt Witcher
* Saturday, March 22, 10-11 a.m., Meeting Room A.
“Breaking Down Ancestral Brick Walls” – Sara Allen
To register for any of these free events, email Genealogy@ACPL.Info or call 260-421-1225.
***************************************

ALA’s Preservation Week: Pass It On
***************************************
Every year, the American Library Association devotes a week to the care and preservation of
documents, artifacts and information. This year, they are encouraging us to “Pass It On,” and The
Genealogy Center is offering a week of events designed to capture, preserve and disseminate the
information and heirlooms of your family. Classes are:
* Sunday, April 27, 1-2 p.m., Meeting Room A.
“Heirloom Succession Planning” – Amy Beatty, C.E.S., G.P.P.A.
*Monday, April 28, 2-3 p.m., Meeting Room A.
“‘To Infinity and Beyond:’ Ensuring Our Family Histories Live Well Beyond Our Years” – Curt
Witcher
*Tuesday, April 29, 2-3 p.m., Meeting Room A.
“Archives 101: Organizing and Preserving the Heirloom Paper in Your Life” – John D. Beatty
* Wednesday, April 30, 2-3 p.m., Meeting Room A.
“Archives 102: Organizing the Bytes in Your Life” – Dawne Slater-Putt
* Thursday, May 1, 6:30-8 p.m., Meeting Rooms A & B.
“An Evening of Storytelling”
*Friday, May 2, 2-3 p.m., Meeting Room A.
“Using iMovie to Capture Family Memories” – Mari Hardacre
* Saturday, May 3, 10-11 a.m., Globe Room
“Up in Lights: Your Family History on Screen” – Cynthia Theusch
To register for any of these free events, email Genealogy@ACPL.Info or call 260-421-1225.
***************************************
Out and About
***************************************
Curt Witcher
February 7, 2014 – RootsTech Conference, Salt Palace, Room 251D, Salt Lake City, UT, 10:30-11:30
a.m. Presentation: “PERSI 3.0: The Next Generation of the Periodical Source Index.”
February 7, 2014 – RootsTech Conference, Salt Palace, Room 251D, Salt Lake City, UT, 2:30-3:30
p.m. Presentation: “Remembering Those Who Have Passed: Why Obituaries Are So Key” (and a
community linking project to make obituary data more accessible).
***************************************
Area Calendar of Events
***************************************
Allen County Genealogical Society
12 February 2014--ACPL Meeting Room, Fort Wayne, Indiana, 6:30 p.m. Gathering time, followed by
business meeting and presentation, “Lincoln Goes Digital: The Lincoln Collection at the Allen County
Public Library,” presented by Curt B. Witcher.
ACGSI Genealogy Technology Group
19 February 2014--ACPL Meeting Room, Fort Wayne, Indiana, 7 p.m.
Historic Fort Wayne’s A Winter Garrison

15-16 February 2014--Historic Fort Wayne, 1201 Spy Run Ave., Fort Wayne, Indiana, 10 a.m.-4 p.m.
Saturday & 10 a.m.-2 p.m. Sunday.
***************************************
Driving Directions to the Library
***************************************
Wondering how to get to the library? Our location is 900 Library Plaza, Fort Wayne, Indiana, in the
block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by
Wayne Street, and the east by the Library Plaza, formerly Webster Street. We would enjoy having
you visit the Genealogy Center.
To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link
at MapQuest:
http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Web
ster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1
>From the South
Exit Interstate 69 at exit 102. Drive east on Jefferson Boulevard into downtown. Turn left on
Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard.
Using US 27:
US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard
and go five blocks. The Library will be on the right.
>From the North
Exit Interstate 69 at exit 112. Drive south on Coldwater Road, which merges into Clinton Street.
Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks.
The Library will be on the right.
>From the West
Using US 30:
Drive into town on US 30. US 30 turns into Goshen Ave. which dead-ends at West State Blvd.
Make an angled left turn onto West State Blvd. Turn right on Wells Street. Go south on Wells to
Wayne Street. Turn left on Wayne Street. The Library will be in the second block on the right.
Using US 24:
After crossing under Interstate 69, follow the same directions as from the South.
>From the East
Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne.
You will be on Washington Blvd. when you get into downtown. Library Plaza will be on the right.
***************************************
Parking at the Library
***************************************
At the Library, underground parking can be accessed from Wayne Street. Other library parking

lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a
$7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the
west end of the Great Hall of the Library. Out of county residents may purchase a subscription
card with proof of identification and residence. The current fee for an Individual Subscription Card
is $70.
Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two halfhours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and
Harrison Street ($3 per day).
Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am –
5pm, weekdays only. It is free to park on the street after 5pm and on the weekends.
Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton
Hotel parking lot that also serves as a day parking garage. For hourly parking, 7am – 11 pm, charges
are .50 for the first 45 minutes, then $1.00 per hour. There is a flat $2.00 fee between 5pm and
11pm.
***************************************
Genealogy Center Queries
***************************************
The Genealogy Center hopes you find this newsletter interesting. Thank you for subscribing. We
cannot, however, answer personal research emails written to the e-zine address. The department
houses a Research Center that makes photocopies and conducts research for a fee.
If you have a general question about our collection, or are interested in the Research Center, please
telephone the library and speak to a librarian who will be glad to answer your general questions or
send you a research center form. Our telephone number is 260-421-1225. If you’d like to email a
general information question about the department, please email: Genealogy@ACPL.Info.
***************************************
Publishing Note:
***************************************
This electronic newsletter is published by the Allen County Public Library's Genealogy Center, and
is intended to enlighten readers about genealogical research methods as well as inform them about
the vast resources of the Allen County Public Library. We welcome the wide distribution of this
newsletter and encourage readers to forward it to their friends and societies. All precautions have
been made to avoid errors. However, the publisher does not assume any liability to any party for
any loss or damage caused by errors or omissions, no matter the cause.
To subscribe to “Genealogy Gems,” simply use your browser to go to the website:
www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be
notified with a confirmation email.
If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of
Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe e-

zine" in the subject line.
Dawne Slater-Putt, CG & Curt Witcher, co-editors

